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1387زمون استخدامی بانک تجارت سال سئوالات آ

 

 فارسی ادبیات و زبان

  است؟ معنی چه به هوش» ... کیست دست بر هوش جهان در را و« مصراع در  .1

 آگاهی و علم) 4  علاقه و میل) 3  مرگ) 2  اندیشه )3

  است؟ کدام ترتیب، به »عنا - استلام شیم،« هاي واژه معنی  .2

 کشی گردن – ها اندیشه – فرستادن درود) 2  سپاس – ها بوي – سرزنش) 1

 مبل - قیمتی سنگهاي – سربرآوردن) 4  رنج – بوسیدن – ها خوي) 3

  است؟ نشده مطرح درست آن، برابر در اثر کدام ي نویسنده  .3

 نیشابوري عتیق ابوبکر – قرآن قصص) 2  الخیر ابی ابوسعید-اسرارالتوحید) 1

 الملک منظا خواجه – نامه سیاست) 4  نیشابوري ابواسحاق – الانبیاء قصص) 3

 است؟ گفته سخن آن، خوانی آواز و بلبل از بیت کدام در شاعر  .4

  عجب لعبهاش و گشت لعبگر***    لبـــس پرند رخ اـــــدیب بــاغ) 1

 قصب کبود چون گشت آسمان***    سبز ستبرق چون گشت بوستان) 2

  مشجب بسدین کرده او شاخ***    دـــبلن ندهـــبرفک زـــسب بیرم) 3

  شغب هزار با است زندبافی***   بر گلبــن شاخ به را ــلیگ هر) 4

 .است گفته سخن شبانه تیرگی از...  بیت از غیر زیر، هاي بیت ي همه در شاعر  .5

 گرد زانگشت برانگیخت زنگی چو***  سرد باد یکی برزد که آنگه هر) 1

  قار دریاي ز خیزد موج کجا***  جویبـار لب و باغ گشت چنان) 2

  چهر اندوده اندر قیر به گفتی تو***  سپـهر خورده زنگار ـولادپ چو) 3

  بد و نیک از بسته زبان زمانه***  دد هـرّاي نه و مــرغ آواي نه) 4

 .است شده اشاره کوه ي قله برف به...  بیت از غیر به زیر، هاي بیت ي همه در  .6

 کمربند یکی میان به زاهن***  خود کلّه یکی سر به سیم از) 1

 افکند پس ها قرن گردش از***  روزگــاري درشت مشت تو) 2

  کردند ضماد آن بر کافور***  نشیــند فـرو ورم و درد تــا) 3

 اورند کبود یکی به بنشین***  معجر سپید این سر ز برکش) 4

  است؟ گفته سخن آسمان، در آن اطراف ستارگان و ماه از بیت، کدام در شاعر  .7

 چکانیش قیر بر که گدازنده زر چون***  دیو سپــس بتـازد که ستـاره به بنگر) 1

1

http://www.esoal24.ir


1387زمون استخدامی بانک تجارت سال سئوالات آ

 

  خزانیش خوب سلبِ همیشه است این***  خز پیــرهن زغمش بپــوشد خورشید) 2

  ندانیش نداف ي کلبه از بنگري گر***  اکنون بد بزّاز ي رزمه چون که کهسار) 3

  اوانیش است وربل پاکیزه و سوده از***  را حبش شاه شب به پیروزه مفرش بر) 4

  .دارند معنایی تناسب زیر، عبارت با...  بیت از غیر زیر، ابیات ي همه  .8

 گردنـد  سیر تو از که کن درشتی چندان نه ببرد، هیبت وقت بی لطف و آرد وحشت گرفتن حد از بیش خشم

  .شوند دلیر تو بر که نرمی چندان نه و

  دهد مذلّت در تن یکباره نه***  نهــد فزونـــی را خویشتن مر نه) 1

  خویش قدر کند ناقص که سستی نه***  پیش خردمنــد نگــیرد درشتــی) 2

  نخست نماید درشتی درستی***   درشت ولیکن پاسخ است درست) 3

  است نه مرهم و جراح که قاصد چو***   است به در هم به نرمی و درشتی) 4

 بعضـی  و گـان،  دده صـفات  بعضی و سطوران صفات بعضی اند، کرده جمع تو باطن در که صفات این« متن در  .9

 از تـو  در را سـباع  و بهـایم  صـفات  این که بدانی تا کن آن طلب. است فرشتگان صفات بعضی و دیوان صفات

 تـرا  که سفري در گیرند سخره روز و شب و کنند سیر را تو تا اند آفریده آن براي را ایشان اند؟ آفریده چه براي

 بـاطن  معنـی  آن تـو  حقیقت سازي خویش سلاح دیگري از و سازي خویش مرکب یکی زا اند، نهاده پیش فرا

  ».است وي تبع است، آن جز چه هر و است

  دو) 4  سه) 3  چهار) 2  پنج) 1

  ... یعنی، »رسید فراضیعتی آمد، کشت ي نظاره به خواجه ادراك وقت به«   .10

  .رسید اي روبهمخ به آمد، محصول سرکشی به بود سرحال خواجه که هنگامی) 1

  .رسید کشتزاري به آمد، محصول تماشاي به خواجه محصول، رسیدن هنگام) 2

  .رسید زمینی و آب به آمد، آن بازدید به خواجه زمین، کاشتن زمان در) 3

  .رسید اي ویرانه به آمد، مزرعه تماشاي به خواجه محصول، کردن جمع وقت به) 4

 آنجـا  مـردم  یعنی، »است ندیده کس درم یک به کمتر نان من هشت رشه بدین هرگز گفتند می آنجا مردم«   .11

   که است ندیده کسی شهر، بدین هرگز گفتند می

  .بدهند نان من هشت از بیشتر درم، یک به) 1

  .بدهند درم یک از کمتر به را نان من هشت) 2

  .بدهند نان هشت از کمتر درم یک به) 3

  .بدهند نان من هشت از بیشتر درم، یک از کمتر به) 4
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 بـه  گزینه، کدام در »سعادت کیمیاي – الحکایات جوامع – مرصادالعباد – العشّاق سوانح« آثار آورندگان پدید  .12

  اند؟ شده برده نام ترتیب

  غزالی احمد – عوفی محمد الدین سدید – رازي الدین نجم شیخ – غزالی حامد ابو) 1

  غزالی حامد ابو – عوفی محمد الدین سدید – رازي الدین نجم شیخ – غزالی احمد) 2

  غزالی ابوحامد – رازي الدین نجم شیخ – عوفی محمد الدین سدید – غزالی احمد) 3

  غزالی احمد – رازي الدین نجم شیخ – عوفی محمد الدین سدید – غزالی ابوحامد) 4

  کند؟ می بیان را خورشید طلوع ي لحظه بیت، کدام مضمون  .13

  خایی ژاژ زبان بت گل***  شــداد ماس نه ارم رسم نـه) 1

  چین ي نگارخانه آفاق،***  سپرغم ســوري و سنبل وز) 2

  عماري نیلگون ي محبوبه***  زرتار زلــف ز گره بگشــود) 3

  خواب ترا شد چون عیان تعبیر***  بند اندرین یوسف مونس اي) 4

 بـه  زیر، ابیات ي همه با »سوخت که عیشم هر سوخت، ما زآتش دوخت چه هر جا هر دوخت، ما سوزن« بیت  .14

  .دارد محتوا و موضوع تناسب...  بیت از غیر

  کنند بد ار کنیم ها پوشی عیب***  کنــند رد را ما چـه ار بخوانیــم ما) 1

  دهیم می فرمان موج و سیل به ما***    دهیم می طوفـان حکم دریا به ما) 2

  ماست سرگردان آب، و باد و خاك***  ماست ایوان از نقشی هستی، نقش) 3

  کنند می آن ما، گوییم می آنچه***  کنند می طغیــان نه خـود از رودها) 4

  باشد؟ حلّاج منصور حسین سرگذشت یادآور تواند می بیت کدام  .15

  کرد می هویدا اسرار که بود این جرمش***  بلنــد دار سرِ گشـــت و کز یار آن گفـت) 1

  کرد می بیضا ید و عصا پیش سامري***  اینجا کرد می که عقل ها شعبده همه این) 2

  کرد می خدایا دور از و دیدش نمی او***  بــود او با خدا احـــوال همــه در دلی بی) 3

  کرد می دریا لب گمشدگان از طلب***  است بیرون مکان و کون صدف کز گوهري) 4

  .است شهودم تشبیه آرایه...  بیت از غیر به ها بیت ي همه در  .16

  ناپسند کردارهاي ي شعله***    بلنــد شد خودپسندي تنــور از) 1

  بریز بین خود ي دیده اندر خاکش***   خیز که فرمودم حکم را اي پشّه) 2

  سوخته ها خانمان شراري وز***  افروخــته بسی آتش عجب برق) 3

  وبال و وزر از بردند ها توشه***  ضــلال تیه در گشتند رهنمون) 4
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  چیست؟ »مغافصه« معنیِ »رسید در مغافصه و آورد می کنده بیخ از بسیار درخت... « عبارت در  .17

  هیاهو و صدا و سر با) 4  شتاب و تندي به) 3  آرامی به) 2  ناگهانی) 1

  چیست؟ زیر، بیت دو پایانی مصراع معنی  .18

  آفرین کنندي من بر زمان هر***  زمین روي همه گر مجنون گفت

  بس و باد لیلی دشنام من مدح***  کــس هیچ آفرین واهمنخــ من

  .گوید می آفرین و مدح من به که انگار کند بدگویی لیلی از کسی اگر) 1

  .گوید می ناسزا لیلی به که است آن مثل گوید، ناسزا مرا کسی اگر) 2

  .گوید می ناسزا من به که انگار گوید ناروا سخنی لیلی به کسی اگر) 3

  .است خوشایند و گوارا برایم آفرین و مدح همچون گوید، ناسزا مرا یلیل اگر) 4

  است؟ کدام زیر، حکایت اصلی سفارش  .19

  بود خام مرد و افتاد قایمش***   بــود حمــام در مهنه بـــوسعــید

  او روي پیش جمله آن کرد جمع***   او بــازوي تـا آورد شیـــخ شــوخ

  جهان در باشد چه جوانمردي تا***   انجــ پــاك اي بگو گفتار را شیخ

  ...ست آوردن نا خلق چشم پیش***  است کردن پنهان شوخ گفتار شیخ

  گناهی بی و عصمت) 4  ملایمت و نرم) 3  پوشی عیب) 2  متقابل احترام) 1

  است؟ کرده یادآوري را رستاخیز حسابرسیِ بیت، کدام در شاعر  .20

  هوي از نه نطقش و طبیعت از نه رایش***  جبرئیــل ز پیامش و جلیل از الهامش) 1

  سها دهد پرتو چه آفتاب پیش خود***  رســد را که فصاحت زبـان او نعت در) 2

  برملا پرده از فتد رازها که روزي***  بپوش ما گناهان خویش لطف به یارب) 3

  عنا بیشتر هم و عنایت بیشتر هم***  اند کشیده بلیت همیشه حق خاصان) 4

  است؟ غلط کلمه کدام املاي زیر، تنم در  .21

 و دارد نگـاه  ایجـاز  شرط الّا و کند جهت واضح هاي مثال به آن بیان در افتد، غامض معنی او سخن در اگر«

 تـا  مسـتان  و دیوانگان و کودکان و عوام ي مخاطبه از و نگیرد لفظ بر شطم و فحش و ننماید ضجرت و قلق

  ».نگوید موحش هاي سخن و نکند محاکات قبح به را کس هیچ افعال و اقوال و حرکات و کند احتراز تواند

  احتراز) 4  ضجرت) 3 غامض) 2 شطم) 1

 و یوسـف  از تقلیـد  به زلیخا و یوسف نام به ي منظومه. است هجري دوازدهم قرن معروف شعراي از وي« متن  .22

 میـدان  ایـن  در و کـرده  اقتفا ويگ پارسی قدیم شعراي روش بر ترانه و غزل و قصیده در. دارد جامی زلیخاي
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 کـدام  اسـت  بده او زمان تا شعرا احوال در تحقیق مهم منابع ي جمله از او ي آتشکده ي تذکره است بوده موفق

  کند؟ می معرقی را شاعر

  شیرازي اهلی) 4 بیگدلی آذر) 3  اصفهانی هاتف) 2  مشتاق) 1

  .است شمرده بر را) ع( علی حضرت لفضای...  بیت از غیر به زیر، هاي بیت ي همه در شاعر  .23

  سخاوتش پیمبر پیش به را درویش***  سؤال بی کرد غنی رکوع در که را آن) 1

  رایتش داد بدو بدر روز حرب در***  آمدند عاجز همه چو مصطفی که ا آن) 2

  امانتش سزاي نبود او جز زیرا***  را ولــرس علــم ي مدینه مر بود در) 3

  برکتش و خیر از دل خیر، و است برکت پر***  یافت قــرار مبــارك قرآن دلم در تا) 4

  دارد؟ مفهومی تناسب بیت کدام با »دام به اوفتند در دیگر صد***   خام شکاري افتادن در از« بیت  .24

  کس هر بر زشت نام کافکند***   بس باشــد همنشست یک عیب) 1

  دشوارست نهچگو تا بین راه***  رهوارست که مبین مرکب رقص) 2

  فروش سفال کاهلی از شد که***  کــوش کاهل طبــع تیــز با اي) 3

  آموزي دانش ز دارد ننگ***   روزي نباشــدش دانـش وانــکه) 4

 تناسـب  زیر ابیات از یک کدام با »عاج تخت از آمد فرود چین شه***  تاج به زندگی برآمود گوهر چو« بیت  .25

  دارد؟ معنایی

  کنج ز زد برون سر ریحانیان چو***  ترنــج شسته روي کاین روز دگر) 1

   کرد آغاز پیوستن پیرایه به***  کـرد باز شب چو سر شَبه درج ز) 2

  برگرفت ره و بدرود کرد شبش***    گرفت در بر به را شب چو سپیده) 3

  سنان رخشان برآورد سپیده***    عنان کرده گرد شب برگشت چو) 4

  معارف اسلامی

 درك رکـوع  در را امـام  کـه  این ي اندیشه به و کند می نیت جماعت، نماز ثواب درك منظور به نمازگزار انانس  .26

 حکمـی  چـه  نمـازش  نه، یا کرده درك را امام آیا که کند می شک رکوع، به رفتن از پس رود، می رکوع به کند

  دارد؟

  .است صحیح فرادي صورت به) 2  . است باطل) 1

  .است صحیح جماعت صورت به) 4  . کند دهاعا را نمازش باید) 3
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  ... نماز بطلان موجب عمداً آن، عدم و ... نماز، گزاردن حین در سلام پاسخ  .27

  است - واجب) 4  نیست – مستحب) 3  نیست -واجب ) 2  است – مستحب) 1

 ترتیب، به سهواً نماز رکنی واجبات در تأخیر و تقدیم و سهواً و عمداً نماز، رکن غیر واجبات در تأخیر و تقدیم  .28

  گیرد؟ می خود به وصفی چه نماز

  صحیح -باطل – صحیح) 2  باطل – صحیح – صحیح) 1

  باطل - صحیح – باطل) 4  صحیح – صحیح – باطل) 3

 نمـاز  و دارد قنـوت  5 آن نخسـت  رکعت که رکعتی دو نماز و دارد رکوع پنج آن رکعت هر که رکعتی دو نماز  .29

  .است...  و...  و...  نماز ترتیب، به دارد قنوت رکعتش هر که رکعتی دو

  عبدین – جمعه -آیات) 2  جمعه – عبدین – آیات) 1

  جمعه - آیات – عبدین) 4  آیات – جمعه – عبدین) 3

 تکـالیف  از تکلیفـی  تقلید بدون مستحبات، و عبادات از دین، ضروریات غیر در مجتهد غیر مکلف انسان هرگاه  .30

  .باشد...  که است صحیح صورتی در شده انجام الیفتک دهد انجام را دین

  واقعی االله حکم بر مبتنی) 2  احتیاط به عمل بر مبتنی) 1

  زنده مراجع از یکی فتواي با موافق) 4  اعلم مرجع فتواي با موافق) 3

  ... که است این »رسلاً الملائکه من یصطَفی االله«:  ي شریفه ي آیه مفهوم  .31

  .باشند می خداوند خوي فرشته گزیدگانبر پیامبران،) 1

  .است تکوینی اصطفاي یک فرشتگان، از خداوند انتخاب) 2

  .باشند می خداوند ي برگزیده رسانان پیام فرشتگان، از گروهی) 3

  .شود می نهاده صفت فرشته پیامبران دوش بر خداوند، رسالت) 4

  .گردد می مفهوم...  موضوع »معلوم اممق له الّا منّا ما و«:  ي شریفه ي آیه در دقت از  .32

  فرشتگان بودن مراتب ذو) 2  وجود و هستی وحدت) 1

  وجود داشتن ضعف و شدت) 4  کاینات بودن مراتب ذو) 3

 مـورد  جز به موارد ي همه در »باز سایه آن او سوي بازگردد***  دراز سایه افکند دیوار چه گر«:  بیت مفهوم  .33

  .خورد می چشم به... 

  یرَه خیراً ذره مثقال یعمل فمن) 2  تعملون کنتم ما الّا تُجزون له) 1

  عنداالله تجدوه خیر من لأنفسکم تُقَدموا ما و) 4  ینظرون قیام فاذاهم اُخري فیه نُفخ اذا و) 3
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 داده رخ از کاینـات  در بـزرگ  انقلابـی  ظهور و جهان در بینی پیش قابل غیر و ناگهانی عظیم، وقایعی حدوث  .34

  ... هاي

  دوم صور نفخ از پس رستاخیز، از پیش) 2  اول صور نفخ از پس رستاخیز، از پیش) 1

  دوم صور نفخ از پس رستاخیز، از پس) 4  اول صور نفخ از پس رستاخیز، از پس) 3

  ... اثبات »ترجعون لا الَینا انّکم و عبثاً خلقناکم اَنَما اَفَحسبتم«:  ي شریفه ي آیه پیام  .35

  پروردگار عدالت به توجه با معاد امکان) 2  پروردگار عدالت به توجه با معاد رورتض) 1

  خلقت بودن حکیمانه به توجه با معاد ضرورت) 4  خلقت بودن حکیمانه به توجه با معاد امکان) 3

 مفهـوم ...  موضـوع  »امنامه ـ فَـی  تُمـت  لَـم  الَّتی و موِتها حین الانفس یتَوفَی االله«:  ي شریفه ي آیه در دقت از  .36

  .گردد می

  توفی انجام به خداوند مستقل فاعلیت) 1

  پاداش و جزاء اعطاي به خداوند مستقل فاعلیت) 2

  خواب و مرگ هنگام به کمال و تمام ارتباط قطع و توفی) 3

  اعمال دادن پاداش کمال و تمام به خداوند جزائی عدل) 4

  .باشد می...  اعلان »الأمرُ و الخَلقُ اَلالَه«:  ي شریفه ي آیه پیام  .37

  مکلّفان به »امر« و تعالی باري ذات به »خلق« اختصاص) 1

  خداوند آمریت و خالقیت پذیرش در بندگی قبول) 2

  »امر« عالم به او مادي غیر بعد تعلق و انسان بودن بعدي دو) 3

  »امر« عالم به او مادي بعد تعلق و انسان بودن بعدي دو) 4

 لـم  و الأرحـام  یغتَنمـوا  لم و الاصلاب یسکنوا لم«: فرماید می که السلام علیه علی – مؤمنان امیر کلام ینا پیام  .38

  است؟ مورد کدام »مهینٍ ماء من یخلقُوا

  .دارند شعور ذي مخلوقات دیگر و انسان با مغایر ماهیتی فرشتگان،) 1

  .مادرانند و پدران ناپاك دامان به نیالوده برگزیدگان انبیاء،) 2

  .تجردند مقام از برخوردار و خداوند نافرمانی از معصوم فرشتگان) 3

  .مادرانند و پدران ناپاك دامان به نیالوده برگزیدگان امامان) 4

  دارد؟ معنایی مناسبت مورد، کدام با »تُبصرون مالا و تُبصرون بما اُقسم فلا«:  ي شریفه ي آیه پیام  .39

  اسرار این کند فهم مستمعی همهه نه – اند تسبیح در همه تان،درخ و دریا و کوه) 1

  سوفسطاییم سوزیش سبب وز – سوداییم من ساریش سبب در) 2
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  نیکوست خویش جاي به چیزي هر که – ابروست و خط و خال و چشم چون جهان) 3

  بالاستی در آنچه دارد زیر در صورتی – زیباستی و خوش و نغز اختران این با چرخ) 4

  گیرد؟ می قرار الهی ي اراده متعلّق چیز چه و است الهی ي اراده عمومیت اصل مبین مورد کدام  .40

  آن خصوصیات تمام حفظ با و مباشر علت از معلولی هر –فیکون کُن له یقولِ شیئاً اراد اذا امره انّما) 1

  آن خصوصیات از خالی و مطلق تصور به فعل وقوع – فیکون کُن له یقولِ شیئاً اراد اذا امره انّما) 2

  آن خصوصیات تمام حفظ با و مباشر علت از معلولی هر –تُرجعون الینا و فتنه الخَیر بالشّر نَبلوکم و) 3

  آن خصوصیات از خالی و مطلب صورت به فعل وقوع – تُرجعون الینا و فتنه الخَیر بالشّر نَبلوکم و) 4

 گـرایش  العصـیان  و الفسوق و الکفَر الیکم کَره و قلوبکم فی زینه و الأیمان یکمال حبب«:  ي شریفه ي آیه پیام  .41

  .باشد می...  همان مفسران اکثر بیان به انسان، دوش بر شده نهاده امانت و است...  به انسان ذاتی

  او اللّهی خلیفه مقام احراز – تقدیس) 1

  او اللّهی خلیفه مقام احراز – دانایی) 2

  او اختیاري هاي گزینش مسوولیت قبول –یزیبای) 3

  او اختیاري هاي گزینش مسوولیت قبول – اخلاق) 4

 مواهـب،  اعطـاي  در موجودات قابلیت تضییع عدم و سعادت به موصل تکالیف جعل و وضع در نورزیدن اهمال  .42

  چیست؟ »لاًرسو نَبعت حتّی معذّبِین کُنّا ما و«:  ي شریفه ي آیه پیام و است کدام ترتیب، به

  تشریعی عدل – جزائی عدل – تکوینی عدل) 2  تکوینی عدل – جزائی عدل – تشریعی عدل) 1

  جزائی عدل – تشریعی عدل – تکوینی عدل) 4  جزائی عدل – تکوینی عدل – تشریعی عدل) 3

 موصـوف  فاعـل  آن شود، مطرح نقصانی، گونه هر از دور به و کمال و استواري غایت در فاعل افعال که گاه آن  .43

  .باشد می...  نظام اش، لازمه که است...  به

  احَسن و اَتقن – قدیر) 2  احَسن و اَتقن – حکیم) 1

  مند غایت و مقدر – حکیم) 4  مند غایت و مقدر – قدیر) 3

 تعلّـق  لیاقـت  کـه ...  محـال  بینجامد، نقیضین اجتماع به آن، تحقّق اما نباشد، ممتنع نفسه، حد فی که امري  .44

  ... را خداوند محدود غیر قدرت

  دارد - عادي) 4  ندارد – ذاتی) 3  ندارد – وقوعی) 2  دارد – وقوعی) 1

 فهـم  معنـاي  به دیگر موجودات اوصاف معانی با الهی اوصاف معانی تفاوت روایی، و قرآنی مضامین به توجه با  .45

  .است آن بر دال...  عبارت مفهوم که...  الهی اوصاف ناپذیري

  معرفته واجب عن یحجبها لم – است) 2  معرفته واجب عن یحجبها لم – یستن) 1
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  صفته تحدید علی العقولَ یطلع لم – است) 4  صفته تحدید علی العقولَ یطلع لم – نیست) 3

  .باشد می...  »الحمید الغنی هو االله و االله الی الفقراء انتم النّاس ایها یا«: ي شریفه ي آیه پیام  .46

  وجوب بر مقدم وجود) 2  وجود بر مقدم وبوج) 1

  الوجود واجب به ممکنات وجودي وابستگی) 4  معلول و علت بین سنخیت ضرورت) 3

 بـه  وصـال  مـانع  اسـتدلال،  و احتجـاج  بـه  پـرداختن  یا الهی مخلوقات ي مشاهده در شدن ور غوطه که گاه آن  .47

  .باشد می...  ارتعب مصداقش که است شده حمایت...  راه از شود، تلقی محبوب

  .دارد ظهوري تو از غیر موجودي هیچ آیا – عقل یا استدلال) 1

  .دارد ظهوري تو از غیر موجودي هیچ آیا – فطرت با دل) 2

  .است خداشناسی هاي نشانه زمین، و ها آسمان آفرینش در مسلماً – عقل یا استدلال) 3

  .است خداشناسی هاي شانهن زمین، و ها آسمان آفرینش در مسلماً – فطرت یا دل) 4

 ي کننـده  جـدا  و دارنـد  سـویی  هـم  مصـداق  کدام با ترتیب، به »خداشناسی« و »خدایابی« مفاهیم از یک هر  .48

  چیست؟ شکّاکان و ملحدان صف از انسان

  خدایابی – خداوند وجود شناخت – خداوند افعال و اوصاف شناخت) 1

  خداشناسی - خداوند وجود شناخت – خداوند افعال و اوصاف شناخت) 2

  خدایابی – خداوند افعال و اوصاف شناخت – خداوند وجود شناخت) 3

  خداشناسی - خداوند افعال و اوصاف شناخت – خداوند وجود شناخت) 4

  است؟ کدام تحیر، گردباد از رهایی راه و دارد اختصاص افرادي چه به حیرت، اشکال ترین متعالی  .49

  عقلانیت برابر در تسلیم – عارفان و پیامبران به) 1

  عقلانیت برابر در تسلیم – شکّاکیت چنگال به گرفتاران به) 2

  طبیعی ماوراي حقایق به یقین و ایمان – عارفان و پیامبران به) 3

  طبیعی ماوراي حقایق به یقین و ایمان – شکّاکیت چنگال به گرفتاران به) 4

 او، هـدف  و شـد  وصـفی  چـه  بـه  موصوف او ي فلسفه و بود که فدهمه قرن اروپاي در گرایی، عقل گذار بنیان  .50

  بود؟ چیز چه از حمایت

  عملی عقل از – نقّاد – دکارت) 1

  نظري عقل از – نقّاد – دکارت) 2

  نظري عقل از – عقلانیت – کانت) 3

  عملی عقل از – عقلانیت – کانت) 4
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  هوش

 به جاي علامت سؤال چه حرفی را باید گذاشت؟  .51

 پ Äچ  Äر  Äض  Ä؟ 

  گ) 4  ك) 3  ق) 2  ف) 1

کیلومتر بـه   15سپس به اندازه  ،دور شود Oکیلومتر به سمت شمال از نقطه  20به اندازه  Aچنانچه متحرك   .52

 چقدر خواهد بود؟ Oاز نقطه  Aفاصله متحرك  ،طرف غرب حرکت نماید

  کیلومتر 20) 4  کیلومتر 35) 3  کیلومتر 25) 2  کیلومتر 15) 1

 ام کلمه در مقایسه با سایر کلمات نامتجانس است؟کد  .53

AGENT, BALL, CHAIR, FRANCE, DOOR  

1 (DOOR  2 (CHAIR  3 (BALL  4 (FRANCE  

 گذاشت؟ توان می سؤالچه حروفی به جاي علامت   .54

 G –پ ) F  4 –پ ) G  3 –ب ) F  2 –ب ) 1

  

کیلومتر در ساعت به یـک   80وار با سرعت کیلومتر در ساعت و یک موتور س 50یک دوچرخه سوار با سرعت   .55

که فاصله صـفر   یاست تا وقت تر عقبکیلومتر از دوچرخه سوار  35از لحظه اي که موتور سوار . روند میسمت 

 ؟کشد میشود چند دقیقه طول 

  دقیقه 80) 4  دقیقه 70) 3  دقیقه 60) 2  دقیقه 50) 1

 چند درصد چهار است؟ ،بیست درصد دوازده  .56

1 (60  2( 50  3 (4  4 (80  

چهار ساختمان را در چهار هفته نظافت نمایند براي نظافت هشت ساختمان در هشت هفتـه   ،اگر چهار کارگر  .57

 چند کارگر نیاز است؟

1 (2  2 (4  3 (6  4 (8  

سـاخت کـه    تـوان  مـی با استفاده از این اعداد چند عدد چهار رقمی . را در نظر بگیرید) 7 ،5 ،3 ،1(چهار عدد   .58

 م آن تکراري نباشد؟رق

1 (20  2 (24  3 (32  4 (16  
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بـدون نگـاه کـردن بـه     . شش گوش سبز و هشت گوي سفید وجـود دارد  ،در یک کیسه برزنتی پنج گوي زرد  .59

 چند گوي باید بر داریم که حتماً یک گوي سبز داشته باشیم؟ ،داخل کیسه

1 (9  2 (12  3 (14  4 (19  

 گذاشته شود؟ به جاي علامت سؤال چه عددي باید  .60

 340و  180و  100و  60؟ و 

1 (10  2 (20  3 (30  4 (40  

  .آن را پیدا کرد. یک تصویر با بقیه تفاوت دارد ،در بین تصاویر داده شده ،65تا  61در سؤالات : راهنمایی

61.   

1 (2  2 (3  3 (4  4 (5  

62.   

1 (2  2 (3  3 (5  4 (6  

63.   

1 (1  2 (3  3 (5  4 (6  

64.   

1 (3  2 (1  3 (5  4 (4  

65.   

1 (1  2 (3  3 (4  4 (6  
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آن . یکی از اشکال سمت چپ اسـت  ي گستردهشکل سمت راست تصویر  ،20تا  16ت در هر یک از سؤالا: راهنمایی 

  :را پیدا کنید و در پاسخ نامه علامت بزنید

66.   

67.   

68.   

69.   

 ؟  .70

کـدام   ،درجـه  90راست در جهت فلش به انـدازه   از چرخش شکل سمت ،75تا  71 سؤالاتدر هر یک از : راهنمایی

 :؟ آن را پیدا کنید و در پاسخنامه علامت بزنیدشود مییک از اشکال سمت چپ نتیجه 

71.   

72.   

73.   

74.   
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75.    

  عمومی اطلاعات

  کیست؟ ایران در شاهی بانک گذار بنیان  .76

  براون ادوارد) 2  ملکم سرجان) 1

  آلدریچ پروفسور) 4  دورویتر بارون ژولیوس) 3

  است؟ بوده زیر هاي شخصیت از یک کدام اسلامی شوراي مجلس رئیس اولین  .77

  نوري ناطق) 4  کروبی) 3  رفسنجانی هاشمی) 2  کنی مهدوي) 1

  است؟ نداشته عهده بر را دارایی و اقتصادي امور وزارت مسئولیت تاکنون زیر هاي شخصیت از یک کدام  .78

  حسینی) 4  شیبانی) 3  نوربخش) 2  مظاهري) 1

  گویند؟ می چه اصطلاحاً را مذهبی آواز موسیقی  .79

  کمپوزیتور) 4  آرانژمان) 3  باریتون) 2  انتم) 1

  روند؟ می بین از کجا در قرمز هاي گلبول  .80

  قلب) 4  معده) 3  جگر) 2  طحال) 1

  دارد؟ را مخصوص جرم بیشترین حرارتی درجه چه در آب  .81

  درجه 4) 4  درجه 100 )3  درجه 50) 2  درجه 125) 1

  است؟ بوده دار عهده را مرکزي بانک ریاست تاکنون یک کدام زیر افراد بین از  .82

  توکلی) 4  نوربخش) 3  شریعتمداري) 2  وهاجی) 1

  :هلیوم کاشف  .83

  جیفرماکسول) 4  پلانک) 3  رادرفورد ارنست) 2  پیرفام) 1

  شد؟ وضع زیر دانشمندان از یک کدام توسط ضرب جدول  .84

  بطلمیوس) 4  جالینوس) 3  فیثاغورت) 2  اقلیدس) 1

  است؟ سینا ابوعلی آثار از زیر هاي کتاب از یک کدام  .85

  الاخلاق تهذیب) 4  الفقه لایحضر من) 3  آثارالباقیه) 2  تنبیهات و اشارات) 1
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  است؟ واقع آفریقا در زیر هاي دریاچه از یک کدام  .86

  رسوپویو) 4  بالکان) 3  آرال) 2  ویکتوریا) 1

  است؟ واقع کجا در »تارانتو« خلیج  .87

  کانادا شرق) 4  ترکیه شمال) 3  ایتالیا جنوب) 2  مکزیک غرب) 1

  است؟ تر قدیمی زیر هاي سبک از یک کدام  .88

  هندي سبک) 2  خراسانی و ترکستانی سبک) 1

  ادبی بازگشت سبک) 4  عراقی سبک) 3

  رد؟دا بیشتري قدمت یک کدام شده ذکر هاي دانشگاه بین  .89

  بال دانشگاه) 4  پراك دانشگاه) 3  هاروارد دانشگاه) 2  آکسفورد دانشگاه) 1

  بودند؟ شناس ستاره زیر دانشمندان از یک کدام  .90

  یحیی ابوزکریا) 2  یحیی بن عیسی) 1

  مجوسی عباس بن علی) 4  خوارزمی عبداالله ابو) 3

 اسـت،  شـاعر  مقصـود  عطـف  نقطه معمولاً که بیت یک و شده سروده متحدالقافیه اشعار آن در که شعر نوعی  .91

  شود؟ می نامیده چه گردد می تکرار

  مثنوي) 4  مسدس) 3  بند ترجیع) 2  مسمط) 1

  شد؟ پیدا اروپا در ادبی نهضت کدام هجدهم قرن در  .92

  رئالیسم) 4  رومانتیسم) 3  ناتورالیسم) 2  کلاسیسم) 1

  است؟ کمتر زیر پرتوهاي از یک کدام شیمیایی اثر  .93

  قرمز ي اشعه) 4  لیزر ي اشعه) 3  بنفش ماوراء ي اشعه) 2  قرمز مادون اشعه )1

  است؟ رنگ سبز محلولی حالت در زیر هاي نمک از یک کدام  .94

  پتاسیم کلرور) 4  باریم نیترات) 3  نیکل سولفات) 2  روي سولفات) 1

  است؟ منقوش فرمان چند بر یهود دین اساس  .95

  فرمان 12) 4  رمانف 9) 3  فرمان 10) 2  فرمان 8) 1

  کرد؟ می سلطنت ایران در پادشاه کدام) ع( عیسی تولید زمان در  .96

  ذوالکتاف شاپور) 4  بابکان اردشیر) 3  اول مهرداد) 2  پنجم فرهاد) 1
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  است؟ نویس بیوگرافی زیر نویسندگان از یک کدام  .97

  تسوایک استفن) 4  ژید آندره) 3  روسو ژاك ژان) 2  بی توین آرنولد) 1

  استوا؟ در یا است بیشتر قطب در اجسام وزن  .98

  است مساوي) 4  استوا در) 3  قطب در) 2  ندارد فرقی) 1

  کیست؟ جهان سورآلیست نقاش ترین بزرگ  .99

  آلمانی دورر آلبرت) 2  اسپانیایی پیکاسو پابلو) 1

  ایتالیایی رافائل سانتی) 4  اسپانیایی دالی سالوادور) 3

  ست؟کی X مجهول ي اشعه کاشف  .100

  رونتگن کُنرادفن ویلهم) 4  هاروي ویلیام) 3  بکدل هاندي) 2  بویل دانیل) 1

  ICDL رایانه يها مهارت

  نیست؟ افزار نرم یک زیر موارد از یک کدام  .101

  office  3 (Acrobat Reader  4 (modem) 2  عامل سیستم) 1

102.  MB 50 است؟ بایت کیلو چند  

1 (102×512  2 (104×5  3 (103×512  4 (103×500  

  نیستند؟ Desktop اصلی آیکون چهار جزو زیر موارد از یک کدام  .103

1 (My Computer    2 (Internet Explorer 

3 (My Network Places    4 (Show Desktop 

104.  Quick launch دارد؟ قرار قسمت کدام در  

  وظیفه نوار) 4  منو نوار) 3  عنوان نوار) 2  وضعیت نوار) 1

  چیست؟ Paint هبرنام پسوند  .105

1 (JPG  2 (gif  3 (tif  4 (bmp 

  کنیم؟ می استفاده دستوري چه از Run منوي از سیستم start up به شدن وارد براي  .106

1 (reg edit  2 (ms config  3% (temp%  4 (کدام هیچ  
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 بـراي  هـم  ستمسی در زبان تنظیمات حالیکه در( شوند تایپ انگلیسی فقط word برنامه در اعداد اینکه براي  .107

  ؟کنید می انتخاب را گزینه کدام) است شده انجام انگلیسی براي هم ،فارسی

1 (tools→options→complex script→numeral→system 

2 (tools→options→complex script→numeral→Arabic 

3 (tools→options→complex script→numeral→Hindi 

4 (tools→options→complex script→numeral→context 

  :صفحه شماره کردن وارد براي  .108

1 (Insert→Header & footer  2 (format→Page numbers 

3 (Insert→Page numbers  4 (Edit→Page numbers 

  است؟ صحیح زیر موارد از یک کدام) صفحه بردارهاي( صفحه دور کادر از استفاده براي  .109

1 (Insert→Borders & shading→Borders 

2 (Insert→Borders & shading →Page Borders 

3 (Format→Borders & shading→Borders 

4 (Format→Borders & shading→Page Borders 

  نیست؟ پارگراف انواع از یک کدام  .110

1 (None  2 (first Line  3 (Handging  4 (Align Right 

  است؟ تا چند Excel برنامه هاي ستون و سطر تعداد  .111

  2048 و 1024) 4  1024 و 30000) 3  300 و نهایت بی) 2  256 و 65536 )1

  چیست؟ Excel فایل یک فرض پیش نام  .112

1 (Excel  2 (Book 1  3 (Test 1  4 (doc 1 

  شود؟ جا خانه یک در حتماً که کند می تغییر طوري متن اندازه گزینه کدام انتخاب با  .113

1 (wrap text  2 (shrink to fit  3 (Merge cells  4 (split cells 

  = MID) 3,  4, "3478910"( چیست؟ روبرو تابع خروجی  .114

1 (891  2 (7891  3 (87  4 (78  

  کرد؟ فعال غیر را راست کلیک Slide show نمایش حالت در توان می پاورپوینت در گزینه کدام کمک به  .115

1 (browsed by an individual windows  2 (Full Screen brows at a kiosk 

3 (show without narration  4 (show without Animation 
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  :از عبارتند ترتیب به ها آن پسوند و پاورپوینت در ها فایل فرض پیش نام  .116

1 (PPT-work book  2 (PPS-PPt 

3 (PPt-presentation  4 (PPS-presentation 

  چیست؟ Slide transition گزینه از هدف  .117

  اسلاید اصرعن حرکت) 1

  اسلاید زمینه پس حرکت) 2

  اسلایدها بین جایی جابه) 3

  Slide show در اسلایدها تمامی اتوماتیک حرکت) 4

 انتخـاب  ... دبای ـ شـوند  داده نمـایش  هـم  سر پشت اتوماتیک بصورت اسلاید یک در موجود عناصر اینکه براي  .118

  :شود

1 (After previous  2 (with next  3 (with previous  4 (on click 

  :بجز هستند اکسس جداول بین Relation ship انواع از همه  .119

  یک به یک) 4  چند به چند) 3  چند به یک) 2  دو به یک) 1

  ؟روند می کار به اطلاعات نگهداري و دریافت براي کدام و اطلاعات استخراج براي گزینه کدام  .120

1 (Table-Report  2 (Query - Table  3 (Table - Query  4 (Form - Query 

  کرد؟ مشاهده کلید صفحه کمک به فرم در را عنصر یک) Properties( مشخصات توان می چگونه  .121

1 (F10  2 (F2  3 (F3  4 (F4 

  چیست؟ فرض پیش صورت به Access هاي فایل پسوند  .122

1 (MDP  2 (DMB  3 (MDB  4 (BDM 

  نیست؟ WEB مرورگر برنامه یک مورد کدام  .123

1 (fire fox  2 (opera  3 (Netscape  4 (firewall 

 ببینـیم  ایم، نموده مشاهده قبلاً که را اینترنتی هاي سایت صفحات بتوانیم Disconnect زمان در اینکه براي  .124

  ؟کنیم می استفاده مورد کدام از

  favorites کردن فعال) History  2 کردن فعال) 1

  مکدا هیچ) Work offline  4 کردن فعال) 3
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125.  Encoding مرورگرهاي در استاندارد Web است؟ کدام  

1 (Arabic windows  2 (Unicode (UTF-8) 

3 (User Defined  4 (مورد سه هر  

  زبان انگلیسی

126. This programs are ……………….. for use on home computers. 

1) similar 2) complete 3) suitable 4) comfortable 

127. having children is a big ………………….. and I'm not sure I'm ready for that yet. 

1) solution 2) procedure 3) employment 4) responsibility 

128. I asked the secretary to …………… how I should fill in the form. 

1) locat 2) protect 3) receive 4) explain 

129. The he main …………… of this meeting is to decide what we should do next.  

1) opinion 2) purpose 3) collection 4) statement 

130. You must decide for yourself. Don't let anyone else ……………….. you. 

1) judge 2) rescue 3) admire 4) influence 

131. I’ m feeling tired. I ………… for six hours. 

1) Work 2) will work 

3) am working 4) have been working 

132. The book ………….. is not in the library. 

1) I need 2) I need it 3) that I need it 4) which I need it 

133. I can't talk to peter. I wish I ……………. How to speak English. 

1) Knew 2) know 3) had known 4) have known 

134. who is ……….. boy in the class? 

1) most intelligent 2) more intelligent 

3) the most intelligent 4) more intelligent 

135. The whole class …………………… 

1) the exercises badly did 2) badly did the exercises 

3) did the exercises badly 4) did badly the exercises 

Leonardo da Vinci is one of the greatest artists of the Italian Renaissance. He (136) ………… at Vinci, 

Italy. He studied painting (137) ………….. Florence. The most(138) ………………. Of his paintings is the 
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Mona Lisa. It (139) ……………….. in the Louver. He Knew the art of making (140) ………….. look nearer 

or father away. In fact, he was a master artist. 

136.  

1) born 2) is born 3) was born 4) had born 

137.  

1) in 2) on 3) at 4) into 

138.  

1) useful 2) famous 3) agreeable 4) disappointing 

139.  

1) hangs 2) stands 3) looks up 4) wonders 

140.  

1) objects 2) pictures 3) subjects 4) passages 

Passage 1: 

There are many different types of reading material (books, cards, charts) which schools use in the 

teaching of reading. this was not always so as you can see if you turn to the article children’s 

Literature. Today there are books at all levels which are both interesting and enjoyable and also 

help children to become better readers. Many contain pictures and diagrams designed to help and 

encourage the young reader. Often a whole series of books offers a step – by – step development 

of reading skills. Each is designed to build on what has been taught in previous books and to 

prepare the reader for what follows in later books. 

In the past, most text books used for the teaching of reading had a "controlled vocabulary". Each 

story in the book used only a small number of words. Because there were so few words (in some 

cases as few as 20) , the stories were not very original or intersesting.  

141.  What is the best title for this passage? 

1) teaching reading 2) Reading materials  

3) Reading problems 4) The young reader 

142. Today, most textbooks ………. 

1) contain boring stories 

2) help children become good readers 

3) have a small number of pictures 

4) are out of touch with the modern word 

143. The word "Each" in line 10 refers to ………… 

1) book 2) skill 3) reader 4) development 
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144. According to the passage, stories in old text books were not interesting 

because they …….. 

1) had a large vocabulary 2) had very few words 

3) were designed for adults 4) were designed by teachers 

145. Which of the following is NOT mentioned as an example of reading materials? 

1) charts 2) cards 3) books 4) diagrams 

Passage 2: 

Normal, healthy people can improve their memories very easily. First of all, learn to relax if you're 

trying to memorize something. You may miss important items if your mind is on something else or 

if you weren't paying attention because of anxiety – you retain information best when you are 

alert and concentrating. If you're having trouble concentrating, increase the flow of oxygenated 

blood to the brain. Despite its small size the brain used 20 percent of the body's oxygen 

requirement. So try to combine study with exercise, particularly the kind of exercise that gets you 

breating faster. Keep your mind fit as well as your body by doing mental workouts. Crosswords, 

scrabble and quizzes all help to keep the mind in shape. 

146. The passage mainly discusses …………. 

1) two ways of remembering  2) how to train your memory 

3) why we forget important items 4) short term and long term memory 

147. The word it's in line 5 refers to …………… 

1) flow 2) blood 3) brain 4) oxygen 

148. According to the passage, in order to memorize something, first you sould 

………. 

1) study hard 2) do puzzles 

3) learn to relax 4) improve your memory 

149. You may forget important things because you ……………. 

1) are anxious 2) pay attention 

3) breathe very fast  4) are concentrating 

150. All of the following help to keep the mind in shape EXCEPT ………… 

1) facts 2) quizzes 3) puzzles 4) crosswords 
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  پاسخنامه

  گزینه صحیح  شماره سؤال

1  2  

2  3  

3  1  

4  4  

5  4  

6  2  

7  4  

8  2  

9  4  

10  2  

11  3  

12  2  

13  3  

14  1  

15  1  

16  2  

17  1  

18  4  

19  2  

20  3  

21  1  

22  3  

23  4  

24  1  

25  2  

26  2  

27  4  

28  4  

29  1  

30  4  

  گزینه صحیح  شماره سؤال

31  3  

32  2  

33  4  

34  1  

35  4  

36  3  

37  3  

38  1  

39  4  

40  3  

41  4  

42  3  

43  1  

44  2  

45  3  

46  4  

47  3  

48  3  

49  3  

50  2  

51  3  

52  2  

53  1  

54  3  

55  4  

56  1  

57  4  

58  2  

59  3  

60  4  

  گزینه صحیح  شماره سؤال

61  4  

62  1  

63  4  

64  -  

65  1  

66  4  

67  1  

68  2  

69  1  

70  3  

71  4  

72  2  

73  3  

74  4  

75  4  

76  3  

77  2  

78  3  

79  3  

80  1  

81  4  

82  3  

83  -  

84  2  

85  1  

86  1  

87  2  

88  1  

89  1  

90  3  
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  گزینه صحیح  شماره سؤال

91  2  

92  3  

93  1  

94  2  

95  2  

96  1  

97  1  

98  2  

99  3  

100  4  

101  4  

102  1  

103  4  

104  4  

105  4  

106  2  

107  2  

108  3  

109  4  

110  4  

111  1  

112  2  

113  2  

114  1  

115  2  

116  3  

117  4  

118  1  

119  1  

120  3  

121  4  

  گزینه صحیح  شماره سؤال

122  3  

123  4  

124  3  

125  4  

126  3  

127  4  

128  4  

129  2  

130  4  

131  4  

132  1  

133  1  

134  3  

135  3  

136  3  

137  1  

138  2  

139  1  

140  1  

141  4  

142  2  

143  2  

144  4  

145  2  

146  3  

147  3  

148  1  

149  1  

150  2  
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